
J River to HQPlayer

© 2018

September 12, 2018



Chapter 1

Introduction

As its name (”J River to HQPlayer”) suggests, this software allows you to use
J River Media center as a “front-end” or library manager, and have the files
played through HQPlayer from Signalyst instead of J River itself.
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Chapter 2

Features

Here is a list of features in the current version:

• Select a track from an album in J River/J Remote and the album will be
loaded in HQPlayer and playback will commence from that track.

• Select a different track from the same album in J River/J Remote and
HQPlayer will navigate to that track.

• Multi-Disc “Box Sets” are supported where the format of the file name
begins with <Disc#>-<Track#>. (Disc number-Track number).

– This format is used simply to identify that the album is a Multi-disc
“Box set”. The actual disc and track numbers will be determined
from the tags set in J River, wherever possible.

– In the case of these Multi-Disc sets, where temporary files need to be
created, only the disc containing the track selected for playback will
be loaded into HQPlayer, with playback beginning from that track.

• For any album which does not contain valid Track# tags (and Disc# tags
where appropriate), the Track# and Disc# will be determined from the
track’s file name wherever possible.

• Automatic creation of temporary files for albums which are in a format
not supported by HQPlayer, such as Apple Lossless.

• Ability to specify the file type of the temporary files. The default is “flac”;
but any of the HQPlayer supported formats may be specified, with the
exception of DFF/DSF (DSD) files.

• Ability to selectively force creation of temporary files for albums, even
though they may be in a format supported by HQPlayer, with the excep-
tion of DFF/DSF (DSD) files.
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• Ability to specify that temporary files will always be created (whether or
not it is necessary) and the format those temporary files are created in.

• Temporary files are deleted as soon as a track from a new album in selected
for playback.

• You specify where the temporary files are created using a path in the “call-
jr-ps.cmd” file shown below. If you never create temporary files leave the
“temps” parameter at it’s default value.

• If you associate the file type of the music files in an album with J River,
and instruct J River to use this external custom program for them, they
will also be played by HQPlayer when you double-click a file from the
album in File Exporer. In that case playback in HQPlayer will commence
from the track you double-clicked on in File Explorer. This permits you
to play music via J River to HQPlayer, even if you haven’t added that
music to a J River internal library.

• All tracks from an Artist may be loaded and played in HQPlayer.

– The tracks may be played in order from each of the artists albums
or shuffled.

– Playback will begin with the track selected for playback in J River/J
Remote.

– The default view may be changed from ’Album’ to ’Artist’ in the
“call-jr-ps.cmd”, file which acts as a settings file. This will result in
all Albums/Tracks from that artist being loaded into HQPlayer.

• J River’s playlists may be played through HQPlayer using this front end.

– Each playlist you wish to playback through HQPlayer must first be
exported in .m3u8 format to the same folder where this script and
its associated files reside.

– Alternatively if you associate .m3u8 files with J River and instruct
J River to use this external custom program for them, they will be
played by HQPlayer when you double-click one of these playlist files
in File Exporer.

– Remember to export “Smart Playlists” periodically to replace older
versions as these playlists are updated dynamically, though only
within J River itself.

– Optionally you may Shuffle the playlist before sending it to HQ-
Player. This is achieved with a custom tag which can be set in J
River/J Remote.

– Playback from the playlist loaded in HQPlayer will begin with the
track selected for playback in J River/J Remote.

– The tracks from the playlist may be played in order or shuffled.
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– The default view may be changed from ’Album’ to <playlist name>
in the “call-jr-ps.cmd”, file which acts as a settings file. In this case
<playlist name> is replaced by the name of the playlist you exported
from J River to the folder containing this script. (The ’.m3u8’ file
extension is excluded from this name in the “call-jr-ps.cmd” file). This
will result in all tracks from that playlist being loaded into HQPlayer.

• Shuffle my be set to ’Yes’ in the “call-jr-ps.cmd” file, in which case whichever
view is set in this same file (Album, Artist or <playlist name>, the tracks
will be shuffled before being loaded into HQPlayer. The default for the
global ’Shuffle’ setting is ’No’.

• Albums, Artists and Playlists may all be played in repeat mode.

• Ability to pause/resume or stop HQPlayer settings from within J River/J
Remote (optional feature, see below).

• Ability to change the following HQPlayer settings from within J River/J
Remote:

– Load an entirely different HQPlayer Settings file.

– Filter

– Shaper (Ditherer or Modulator)

– Sample Rate

– Mode (Auto, PCM or SDM (DSD))

– The HQPlayer settings to apply are determed from custom tags,
which you first have to set up within J River.

– The HQPlayer settings that will be applied are determined by how
the tags are set in the actual track(s) selected for playback.

– Use of this feature is entirely optional. You are not obliged to set-up
custom library fields to create these tags in J River, or enter values
for the tags. If the tags are not present or are empty the settings
that you have in place in HQPlayer will be applied, until you change
them within HQPlayer itself.

– You should, however, always have a ’default.xml’ settings file which
you have created and exported from within HQPlayer itself, for the
settings you wish to be applied in the majority of cases. Any settings
you apply to particular tracks or collections of tracks via the custom
tags will be treated as exceptions to the default settings.

– It may also be useful for you to create a settings file named ’ex-
treme.xml’ for cases where the ’poly-sinc’xtr’ family of filters will be
applied. (See below).

– At all times where specific HQPlayer settings are requested, a check
is made to detemine if the Filter, Shaper, Sample Rate or Mode you
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have set in the tag is available. These settings are all context de-
pendant and only the settings available in HQPlayer, will be applied.
This depends on several factors, such as, the DAC you are using,
the mode which is being applied, and the sample rate and format of
the original source file. The available settings are fetched prior to
determing if the settings you’ve requested can actually be applied.
Any settings from custom tags which cannot be applied will be ig-
nored. The Mode setting is attempted first, so the filters and shapers
available for that mode can be fetched.

• Apart from Artists and Playlists, by default this front end to HQPlayer
will always assume you want to play from an album. So only the tracks
from the album containing the track selected for playback, will be loaded
into HQPlayer. The implications of this are that if you start playback
from any view other than “Artist” “Album” or a “Playlist”, the only tracks
which will be loaded are the rest of the tracks from the Album which
contains the track selected for playback. To get around this, if you want
to play from, say the Genre view, you should create a playlist for this
genre (if it doesn’t already exist) in J River and export it in .m3u8 format
to this script’s folder.

• There is one exception to the above rule and that is “Podcasts”. Podcasts
which you’ve downloaded to J River can be played back through HQPlayer
from J River/J Remote. In that case only the episode selected for playback
will be loaded and played back in HQPlayer. Each episode is a single track.
A temporary file will be created for the Podcast episode as it will be in a
format, such as MP3 which is not supported by HQPlayer.

• Additionally from version 1.12 onwards there is limited support for playing
streams from the Qobuz and Tidal services. Two options exist for this as
follows:

– Playing from a UPnP server with J River set up as a DLNA/UPnP
renderer.

∗ Unfortunately this is limited to just one track at a time, because
once the UPnP stream URL is handed over from J River to
HQPlayer the sync between the UPnP server and J River is lost
and playback also stops in the UPnP server. For one track at a
time playback, it is fine though. So if you enjoy playing dj, this
might be for you. I’ve tested this with the apps “mconnect” on
IOS and BubbleUPnP on Android.

∗ For continous playback to be achieved on Windows the only so-
lution I know of is my own “Supersonic” add-on for Kodi. This
can send the stream urls directly from Kodi to HQPlayer though,
so you might ask, “why involve J River as another middle-man?”.
It does work well though, especially as from version 1.5 onwards
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of Supersonic, Kodi’s own playback of the streams can be op-
tionally turned off. Continuous playback is still achieved, since
Supersonic waits for the duration of the currently playing track
before fetching the next url from Qobuz or Tidal. If you have
both J River and Kodi you might want to compare the following
options to determine which works best for you:

· Kodi -> Supersonic -> J River -> HQPlayer.
· Kodi -> Supersonic ->HQPlayer.
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Limitations

The only real limitation some people may object to is that there is no indication
of what is playing or playback progress in J River/J Remote. That’s because
nothing is playing in J River! All playback is in HQPlayer. I actually consider
this a feature, because J River is using absolutely no resources during playback
as far as I can tell, and so can’t be having any impact on sound quality.

Once again, if you need feedback on what’s playing or playback progress,
other than using your ears, a temporary VNC session to take a look at HQPlayer,
is all I can suggest, for a “headless” server (without Monitor, Mouse, Keyboard).
If your server is not headless, then obviously you can look at the monitor.
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Installation

You will receive/have received the distribution in a .zip file named, jr-hqp.zip.
When you extract it you will find the following files/directories in a folder

named “jr-hqp”:

• log.text

– Used for de-bugging

• jrexp.ps1

– The actual script

• vars.text

– Also used for de-bugging

• arguments.txt

– The arguments you need to paste in to J River’s file association,
“arguments” field

• temps.text

– A record of the temporary files which have been created.

• album.text

– A record of the Album currently playing

• artist.text

– A record of the Artist currently playing

• playlist.text

– A record of the Playlist currently playing
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• current_tracks.text

– A record of the currently loaded Artist or Playlist

• track.text

– A record of the currently playing track

• HQPlayer Rates.txt

– An example of the format for HQPlayer rates, so you can set them
correctly in J Remote/J River (if you wish to).

• call-jr-ps.cmd

– The initial script that gets called by J River and passes the arguments
to the Powershell script.

• change log.txt

– Summary of changes up to this version

• ffmpeg

– A distribution of ffmpeg needed to create any temporary files.

• Manual.pdf

– This manual.

Move the extracted “jr-hqp” to whichever location you desire.

4.1 The all important “call-jr-ps.cmd” file
This is the file which J River will need to point to, when you set up a file type
in J River to point to this External (custom) program for that file type.

Here are the contents of the “call-jr-ps.cmd” file:

set datapath=%~dp1

not editable leave as is

set filepath=%~f1

not editable leave as is

set extension=%~x1

not editable leave as is

set temps=C:\temp

. . . or any valid path
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set hqpath=C:\Program Files\Signalyst\HQPlayer Desktop 3\hqp-
control.exe

Your path to the hqp-control.exe program if it differs from
this, otherwise leave alone.

set stoppause=No

Set to ’Yes’ if you want to use stop and pause features.
(See below) otherswise leave alone.

1. If you set this to “Yes” the following behaviour will
occur:
(a) Tapping in J Remote/J River on the track that’s

currently playing will cause playback to pause in
HQPlayer.

(b) Tapping on that same track again in J Remote/J
River will cause playback of that track to resume
in HQPlayer from the point where it was left when
paused.

(c) Tapping on any other track in J Remote/J River
(either from the same or a different album) will
cause playback in HQPlayer to stop.

(d) Tapping on that same track, or any other track
in J Remote/J River will cause playback to start
from that track in HQPlayer. Any new tracks
which need to be loaded, will first be loaded into
HQPlayer, after clearing current tracks.

set alwayscreatetemps=No

Set to ’Yes’ if you wish temporary files to be created in all
cases. Otherwise leave at ’No’.

set tempformat=flac

set to either ’wav’ or ’aif’ if you prefer any temp files to
be created in one of these formats. Otherwise leave at the
default ’flac’.

set view=Album

Set to ’Artist’ if you want all tracks loaded for that artist,
or set to the name of a playlist exported from J River
to the folder where this script resides, in .m3u8 format.
Othewise just leave at the defualt ’Album’.

set shuffle=No
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Set to ’Yes’ if you want the ’Album’ ’Artist’ or playlist
tracks shuffled before loading to HQPlayer. Otherwise
leave at the default ’No’.

powershell -Mta -executionpolicy bypass C:\jr-hqp\jrexp.ps1

You must not alter the first 3 lines of this file and you will only need to alter
one or more of the remaining lines if you wish to apply something other than
the defaults shown here.

1. Please place the jr-hqp folder at the root of your C: drive. This will ensure
the powershell script is correctly found as per the last line above..

2. Save the file after making the necessary changes and you’re done with the
script installation part. Next we need to configure “J River Media Center”
to use this script.



Chapter 5

Configure J River Media
Center

5.1 Required
The most important steps to configuring Media Center are as follows:

1. With Media Center’s main interface window open on your screen, choose
“Options” from the “Tools” menu.

2. Choose Tools->Options

3. In the left hand pane of the window that appears choose “File Types”
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4. Choose File Types

5. For each File Type where you want the music files to be played through
HQPlayer instead of Media Center, under “Audio” click to select the File
Type in the main list of file types. The example here is “AAC”. (Inci-
dentally for Apple Lossless to be associated with HQPlayer you’ll need to
associate both AAC and ALAC file types with this script).

6. Underneath the list of file types place a check mark in the “File Associa-
tion” box.

7. In the drop down menu next to “Playback Method”, choose “External
Program (custom).

8. The field next to “Program:” will need to hold the path to the calling
command (“call-jr-ps.cmd”). Click on the Browse button next to this field
to navigate to where you have this .cmd located (along with the rest of
the scripts files).

(a) Note, you will have to ensure that “All Files (*.*)” is chosen from the
drop down menu next to the “File name” field in the “Select Filename”
window, as “.CMD” files do not show up by default.
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9. Navigate to the .cmd file

10. In the “Arguments” field (which isn’t labelled; but appears underneath
the “Program:” field) you will need to enter the string of arguments that
needs to be passed to the calling script.

(a) Note: the arguments list shown in the image has since changed. Use
the appropriate argument string from the text below.

(b) The easiest and safest way to do this is to copy the argument string
from the “arguments.txt” file supplied alongside this script and paste
the string into this field.
The arguments are also repeated here:

i. Minimum options:
A. "Replace([Filename], &, ^&),[Disc #],[Track #]"

ii. Full options are not as follows:
A. "Replace([Filename], &, ^&),[Disc #],[Track #],[HQPlayer

Filter],[HQPlayer Shaper],[HQPlayer SR],[HQPlayer Type],[HQ-
Player Temp Type],[HQPlayer Temp],[HQPlayer Settings],[Load
Playlist],[Playlist Shuffle],[Artist Play All],[Repeat All]"
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11. Arguments field pasted

12. Repeat this series of actions for each of the file types that you wish to be
played through HQPlayer.

That’s it! You don’t need to go any further for music files in these file formats
to be played through HQPlayer.

The next section will walk you through the procedures you’ll need to carry
out to take advantage of each of the additional features this J River Front End
to HQPlayer provides.

For these to work you will need to have pasted the full argument string:
"Replace([Filename], &, ^&),[Disc #],[Track #],[HQPlayer Filter],[HQPlayer

Shaper],[HQPlayer SR],[HQPlayer Type],[HQPlayer Temp Type],[HQPlayer Temp],[HQ-
Player Settings],[Load Playlist],[Playlist Shuffle],[Artist Play All],[Repeat All]"

5.2 Optional
These optional features are provided by Media Center’s “Custom Library Fields”.
These show up as tags, which can be set within Media Center or the J Remote
apps on IOS or Android.

5.2.1 Repeat All feature
This feature simply causes whatever, Album, Artist, Playlist or Podcast is being
played by HQPlayer to be repeated, until you choose the next item to play
through HQPlayer with repeat set to “No”.

1. Once again choose “Options” from the “Tools” menu. This time select
“Library & Folders” from the left window pane.
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2. Choose “Library & Folders”

3. Click on “Manage Library Fields”

4. On the left hand side under the list of current Library Fields click on hte
“Add New Field” button.
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5. Add New Field

6. Type “Repeat All” exactly as shown and click on the “OK” button.

7. Enter the options and parameters exactly as shown for “Repeat All” in the
“Manage Library Fields” window.

8. Complete details for Repeat All

(a) In the “Flags” drop down menu, uncheck all “Flags” apart from Audio.

(b) Under “Data” Select “User Data” and ensure all the fields and check
marks are as shown in the Manage Library fields image:

i. “Data Type:” = String
ii. “Relational:” = Not relational (store one value for each file)
iii. “Edit Type:” = Standard

9. Once you’ve ensured the correct values are completed, click on the “OK”
button.

10. Now our “Repeat All” custom field will show up as a Tag in all audio files.
It can only have an effect on HQPlayer run via this script.
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11. “Repeat All” and all the other optional tags described in this section will
only show up under “Meta-Data” in the J Remote app, if they actually
hold a value. There are only two possible values for the “Repeat All” tag:

(a) Yes

(b) No
Any other values entered for this tag will simply be ignored.

12. In order to ensure the “Repeat All” tag will show up in J Remote, it needs
to have a value. Since we don’t usually want to repeat the Albums; etc.
we play, we’ll set this default value to “No” for all files.

13. In Media Center’s main interface, under the “Audio” view click the right
pointing arrow if necessary to reveal the Audio categories.

14. Choose “Files”

15. Single click on any file and hit “ctrl+A” on your keyboard or choose “Select
All” from the Edit menu, to select all the Audio files in your library.

16. Select All audio files

17. Right-click (or equivalent) anyhere in the selected file list and choose “Tag”
from the drop down menu.

18. Make sure “Show All Tags” is selected in the small drop down menu at the
top left hand corner of the Tags list.
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19. Show all tags

20. Scroll as necessary to reveal the “Repeat All” tag you’ve just created.

21. Click in the value field next to it and type “No”.

22. As long as you have all the files still selected in your library, the “Repeat
All” tag will be updated in Media Center’s library for each file. The
amount of time this takes, will obviously depend on the size of your library.

23. Finally let’s verify that the “Repeat All” tag does indeed show up in the
J Remote app with the value “No”.

24. Open the J Remote app on your device and select any Audio File. For
this demonstration, I’m using the J Remote app on my iPad.

25. On iPhone you need to hold your finger down on a track until the “Meta-
Data” is displayed for that track. J Remote on iPad provides access to
the Meta-Data by tapping on the “i” button.

26. Tap on “Meta-Data” and scroll as necessary until the “Repeat All” tag
shows up.
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27. J Remote showing “Repeat All”

28. If you were to scroll up to the top of this screen and tap the “Edit” button,
then change the value of “Repeat All” to “Yes”, save the changes and play
from this track, HQPlayer would be placed in “Rpt” mode and the entire
album would be played on repeat.

29. “Repeat All” will be turned off as soon as playback is started for a track
from another Album which has the “Repeat All” tag set to “No”. Before
you do that you might want to set it back to “No” for the track in this
example, if you want to avoid the album being repeated each time you
start playback from this track.

30. If, on the other hand, you want this album to be repeated when you play
it, regardless of which track playback is started from, then when you edit
the “Repeat All” tag for any track of the album, you will want to choose
the option to save the change to all tracks of the album.

In most cases you won’t want to make use of the a ’Repeat All” tag. It is only
shown here as a simple example of how to set up a custom tag in J River. The
procedure outlined here applies to all the custom tags used by this script. The
tags are all set up the same way, with one small exception, shown at the end of
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this section. Their names must be entered exactly as shown in the list of these
tags below. The possible values are also shown below for each tag.

The tag names correspond exactly to those shown in the arguments.txt file
and used in the arguments field we completed under Chapter 5, Section 5.1
Required.

5.2.2 HQPlayer Settings tags
• HQPlayer Settings

– The name of a settings file created and exported from HQPlayer
(excluding the .xml extension).

– The ability to load a settings file allows you to change all settings for
HQPlayer in one go, whereas the remaining tags shown below only
apply to the setting name indicated by the tag name (i.e. ’Filter’,
’Shaper”; etc.).

• HQPlayer Filter

– Sets HQPlayer’s upsampling filter

– Possible values:

∗ In PCM mode:
· none
· IIR
· FIR
· asymFIR
· minphaseFIR
· FFT
· poly-sinc
· poly-sinc-mp
· poly-sinc-short
· poly-sinc-short-mp
· poly-sinc-hb
· poly-sinc-ext
· poly-sinc-mqa
· poly-sinc-mqa-mp
· poly-sinc-xtr
· poly-sinc-xtr-mp
· sinc
· polynomial-1
· polynomial-2
· minringFIR
· minringFIR-mp
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· closed-form
· closed-form-fast
· closed-form-16M

∗ In SDM (DSD) mode:
· poly-sinc
· poly-sinc-mp
· poly-sinc-short
· poly-sinc-short-mp
· poly-sinc-hb
· poly-sinc-ext
· poly-sinc-mqa
· poly-sinc-mqa-mp
· poly-sinc-xtr
· poly-sinc-xtr-mp
· poly-sinc-2s
· poly-sinc-mp-2s
· poly-sinc-shrt-2s
· poly-sinc-shrt-mp-2s
· poly-sinc-hb-2s
· poly-sinc-xtr-2s
· poly-sinc-xtr-mp-2s
· minringFIR
· minringFIR-mp
· closed-form
· closed-form-fast
· closed-form-16M

• HQPlayer Shaper

– In PCM mode:

∗ none
∗ NS1
∗ NS4
∗ NS5
∗ NS9
∗ RPDF
∗ TPDF
∗ Gauss1
∗ shaped

– In SDM (DSD) mode:
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– DSD5

– DSD5v2

– ASDM5

– DSD7

– ASDM7

– DSD5v2 256+fs

– DSD7 256+fs

– AMSDM7 512+fs" 7

• HQPlayer SR

– In PCM mode:

∗ 0
∗ 32000
∗ 44100
∗ 48000
∗ 64000
∗ 88200
∗ 88200
∗ 96000
∗ 128000
∗ 176400
∗ 192000
∗ 256000
∗ 352800
∗ 384000
∗ 512000
∗ 705600
∗ 768000
∗ 1024000
∗ 1411200
∗ 1536000

– In SDM (DSD) mode:

∗ 0
∗ 2048000
∗ 2822400
∗ 3072000
∗ 4096000
∗ 5644800
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∗ 6144000
∗ 8192000
∗ 11289600
∗ 12000000
∗ 12288000
∗ 22579200
∗ 24000000
∗ 24576000
∗ 45158400

• HQPlayer Type

– Auto

– PCM

– SDM (DSD) S

If you choose to enter one of these values into its corresponding tag, the value
must be entered exactly as shown above.

When setting up a custom library field in J River you can limit the allowed
values by using the acceptable values field. The acceptable values are seperated
by a semi colon, as follows:

HQPlayer Shaper = none;NS1;NS4;NS5;NS9;RPDF;TPDF;Gauss1;shaped;DSD5;DSD5v2;ASDM5;DSD7;ASDM7;DSD5v2
256+fs;DSD7 256+fs;AMSDM7 512+fs

There’s no need to enter all possible values in the “Acceptable values” field; just
the ones you are likely to apply, which could be a sub-set of these. The same
applies to HQPlayer Filter, HQPlayer Type (mode) and HQPlayer SR (sample
rate).

5.2.3 Default settings file
You should always have a ’default.xml’ file created and exported from HQPlayer
for the settings that you most usually apply. Any other settings via the above
custom tags will be exceptions to those in the ’default’ settings file.

J River to HQPlayer will always re-load the default settings file before ap-
plying settings in any of the above custom tags. This ensures you always return
to the detault settings where no custom tags have been set.

5.2.4 Considerations for DSD
If you have DSD/SDM format files, with extensions .dsf or .dff the HQPlayer
Filter for up-sampling PCM will have no effect on the sound at all. The modu-
lator will though. It is the combination of the Modulator (e,g, ASDM7) and the
Integrator that effect sound quality when up-sampling DSD files. The Integra-
tor is set in the DSDIFF/DSF settings dialogue box accessed from HQPlayer’s
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’File’ menu. If ’Direct SDM’ is checked in this dialogue box, DSD files will not
be up-sampled. No HQPlayer DSP will be applied to DSD files in that case.
This may turn out to be you preference for those files, or it may not. As usual
experimentation is in order.

5.2.5 Special considerations for the poly-sinc-xtr filters
The poly-sinc-xtr (non-2s variant) family of filters in HQPlayer, may require
the ’Multicore DSP’ box in HQPlayer’s settings to have a check mark placed in
it, whereas with other filters the general recommendation is for this box to be
filled with grey. The three options for this box are:

• Empty

• Check mark

• Filled with grey

I have found that on two very different music server machines, I could only get
reliable playback with this family of filters, when this box had a check mark
placed in it. Whereas the ’closed-form-16M’ filter this box needed to be filled
with grey for reliable playback. In both cases this was when up-sampling to
the maximum DSD sample rate that these machines could handle, when up-
sampling from PCM to DSD.

If you are experiencing the same on your machine, you may want to create
an HQPlayer Settings file named ’extreme’ and export it from HQPlayer.

If any of the ’poly-sinc-xtr’ family of filters is being applied by one of the
custom settings files to the music you’ve requested for playback, j River to
HQPlayer will first look for a settings file named ’extreme’ and, if it exists, will
apply it. Any exceptions will then be applied on top of the settings from this
’extreme’ settings file, rather than the ’default’ settings file.

5.2.6 Settings for temporary file creation
• HQPlayer Temp Type

– flac

∗ The default format used for temporary files.

– aif

– wav

• HQPlayer Temp

– No

– Yes

∗ Forces creation of temp files at all times, except where the orig-
inal file is in dff/dsf format (DSD files).
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5.2.7 Playlist related
• Load Playlist

– No

– <Playlist Name>

∗ The name of a valid Media Center playlist exported from your
Media Center library in “.m3u8” format, to this script’s folder,
e.g. “Blues” (entered without the double quotes).

• Playlist Shuffle

– No

– Yes

5.2.8 Artist related
• Artist Play All

– No

– Yes

∗ Results in all the files by the artist being loaded and played.
Playback commences from the track selected for playback in J
Remote/J River.

• Playlist Shuffle

– No

– Yes

∗ The tracks by the artist are shuffled before being loaded in HQ-
Player. Playback commences from the track selected for playback
in J Remote/J River.

5.2.9 Playback control
Only applicable if the “stoppause” parameter in the call-jr-ps.cmd file is set to
“Yes”

• Pause

– When you tap on the currently playing track it will be paused.

– The next time you tap the same track, playback will resume for that
track from the point where it was paused.

• Stop
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– When you tap on any track within the currently playing Album,
Artist or Playlist, HQPlayer playback will be Stopped, unless it is
the currently playing track, in which case it will be paused.

– If playback was stopped, the next time you tap on any track in the
current album, playback will be started in HQPlayer from the begin-
ning of that track.

– If you tap on a track in a different album, artist or playlist, that
album will be loaded and playback will commence from the track
you selected.

5.2.10 Artist related custom library field.
All of these custom tags are set up in exactly the same way as the first example,
which was the Repeat All tag. The tag name and the value you wish to set it
to must be entered exactly as shown above.

If you wish these tags to show up in J Remote you will need to set all the
tags to their default values as shown under section 5.2.1, the Repeat All feature.

The only differences are that the “Artist Play All” tag is associated with the
artist. That means that when the tag is edited from JRemote/Jriver for just
one track by that artist, the edit will apply to all tracks of the artist.

So for the Artist Play All tag, in the drop down menu next to the relational
field in the “Manage Library Fields” window, you need to select “Store one value
for each artist.



Chapter 6

Conclusion

For those of you who are used to using JRiver Media Center and appreciate
it’s powerful features for managing libraries of locally stored files; but want to
use it in conjunction with HQPlayer to take advantage of the particular sonic
qualities HQPlayer offers, here is one solution that will allow you to use the two
together.

I hope you get a lot of pleasure from it.
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